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Abstract

The CO99-F9P board enables customers to evaluate RTK operation with the ZED-F9P high precision
GNSS receiver. The board provides short-range wireless connection via Bluetooth® or Wi-Fi for
receiving correction data and logging via wireless connectivity.
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1 Introduction

The C099-F9P board is a convenient tool that allows customers to become familiar with the u-blox
ZED-F9P high precision GNSS module. The board provides facilities for evaluating the product and
demonstrating its key features. The C099-F9P application board offers:

e A ZED-F9P module for use as an RTK rover or reference station

e An ODIN-W?2 short-range module to provide untethered operation using Bluetooth and Wi-Fi

e Power supply options comprising a USB connection, Li-Po (lithium polymer) cell with recharging
ability, and 6-17 V DC input’

e Small, lightweight board (110 x 55 mm) with Arduino R3/Uno shield connections for host
expansion

The C099-F9P board allows for two alternative firmware versions to be used with the ODIN-W2
short-range module. These are:

1. C099-F9P Mbed3 application firmware. This is the default ODIN-W?2 firmware pre-loaded to CO99-
FOP boards.

2. ODIN-W2 u-connectXpress software. This is the standard firmware for ODIN-W2 modules. See
section 7.2 on how to change to this firmware.

ZF This User guide describes how to use the CO99-F9P board with the ODIN-W2 u-connectXpress
software.

This User guide describes the following use cases:

1. Base and rover operation via serial connectivity
2. Base and rover operation via Wi-Fi (with ODIN-W2 u-connectXpress software)
3. Rover operation via Bluetooth Classic (with ODIN-W2 u-connectXpress software)

This User guide is split into several sections:

e Section 2 C099-F9P quick start provides information on how to get C099-F9P up and running
straight out of the box.

e Section 3 C099-F9P description identifies the board’s facilities.

e Section 4 Using the CO099-F9P provides a comprehensive guide for in-depth usage.

e Section 5 Rover operation using NTRIP shows different ways of connecting to an NTRIP service.

e Section 6 Reference station and rover pairing shows pairing using two C099-F9P boards as a
reference/rover pair.

e Section 7 Firmware update provides instructions for updating the firmware of the ZED-F9P high
precision GNSS module as well as the ODIN-W?2 short-range module.

e Section 8 Arduino header connections provides mechanical specifications for Arduino R3/Uno.

e The sections in the Appendix provide the u-blox configuration files and give information on C099-
FIOP antenna schematics, and C099-F9P mechanical board dimensions and schematics.

" The C099-F9P kit does not contain a battery or an external power adapter.
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1.1 Package contents

The delivered package contains:

e CO099-F9P board (rev. E)

e u-blox ANN-MB-00 multi-band GNSS antenna and ground plane
e Wi-Fi/Bluetooth antenna

e USBinterconnect cable

e Quick start guide

e USB-to-DC plug adapter cable

Figure 1: C099-F9P board and antennas

1.2 Additional sources of information

Prior to using the board, it is useful to download the appropriate evaluation software and keep handy
the documents listed in the Related documents section.

UBX-18055649 - RO8 Introduction Page 6 of 51
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2 CO099-F9P quick start

This section provides some quick steps to enable ZED-FOP operation before exploring the more
complex configurations described later.

USB port ZED-F9P LEDs ZED-F9P module ZED-RF connector

Figure 2: Basic C099-F9P overview with details needed for quick start

2.1 Startingup

e Connect the supplied multi-band GNSS antenna to the ZED-RF SMA connector. Ensure good
signal reception.

e Connect the USB to a Windows PC; this will power the board. The FTDI and USB drivers will be
installed automatically? from Windows Update when the user connects the board for the first
time. Note that the board has current limitation functionality on USB. Thus, ZED-F9P and ODIN-
W2 modules will power up after the drivers have been successfully installed and the USB
enumeration is completed.

e Start u-center and connect to the COM port identified as C099 application board, ZED-F9P using
Device Manager. Set the baud rate to 460800 baud. See section 4.3.1 for detailed instructions.

e The time pulse LED on the C099-F9P board will blink in blue. Figure 3 below shows a typical
u-center view with active satellite signal levels.

To operate the ZED-F9P in RTK mode, the GNSS antenna must be placed in an open environment and
the unit must be connected to an RTK correction service. Where available, the evaluation kit comes
with a free trial of the SmartNet correction service. Consult the leaflet included with the kit for
information on how to register for the service and how to obtain mount point and user connection
details before moving to the next steps.

RTK corrections can be applied using a u-center built-in NTRIP client. To use the C099-F9P board with
a correction service follow these next steps:

e Inu-center, click on the Receiver menu item.

e Select NTRIP Client...

e Fillin the settings for the NTRIP caster, username and password.

e Click Update source table and select the recommended NTRIP mount point.

¢ Click OK to close the dialog and connect to the service.

¢ In the Data View of u-center, the Fix Mode should change from 3D to 3D/DGNSS when RTCM
corrections are received. The RTK LED will blink in green.

2 For manual driver installation, check GNSS Sensor and VCP Device Driver User guide in Related documents

UBX-18055649 - RO8 C099-F9P quick start Page 7 of 51
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e Eventually, the status will change to 3D/DGNSS/FIXED and the RTK LED will show a steady green

light.
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Figure 3: u-center showing a view of the ZED-F9P default operation
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3 CO099-F9P description

3.1 Component overview

The C099-F9P houses the ZED-F9P RTK high precision positioning module and an ODIN-W?2 module
for wireless short-range communications. An FTDI component provides dedicated COM port
connections with the ZED-F9P and ODIN-W?2 via a USB connector.

The board can be powered by USB, a DC supply socket, or by a Li-Po (lithium polymer) battery. The
board has been designed using an Arduino form factor with the modules’ serial ports routed to the
shield headers. Note that a secondary USB power source is available via the USB-to-DC plug adapter
cable.

The block diagram in Figure 4 shows the logical signal flow between the individual parts.

Arduino shield

Serial GPIOs

SPI

ODIN-W2

BT Serial

SPP Client/Semer UART1 UART2

COMZED |COM ODIN

FTDI
ZED-F9P

USE Hub

SPP ClientySamnear

BT

User equipment

Figure 4: C099-F9P block diagram

3.2 Component identification

The following images show the position of major parts and user interfaces.

e Main components - Figure 5
e Switches and LEDs - Figure 6

The function of these are described later on in this section.

UBX-18055649 - RO8 C099-F9P description Page 9 of 51



@blox C099-F9P - User guide

GNSS antenna connector

Wi-Fi/BT antenna connector

ZED-F9P multi band GNSS RTK module

ODIN-W2 multi-radio module

Je2, J3,J8, J9
Arduino Uno connectors

DC power jack

Battery connector

USB (ZED-F9P USB and UART,
ODIN-W2 UART ports)

Figure 5: Main components and USB ports
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ZED-F9P and ODIN-W?2 reset button

ZED-F9P safeboot button

ODIN-W2 switch O interrupt button

ODIN-W?2 activity LED

ODIN-W?2 safeboot pins

GNSS LEDs: TP, RTK, Geofence

Battery charger LED

Battery incorrect polarity indicator
LED

Figure 6: Switches and LEDs

ZF The MicroSD card slot is not used in this version of the board. The ODIN-W2 Switch 0 interrupt is
not required for normal customer use.

3.2.1 ZED-F9P status LEDs

The board provides three LEDs to show the ZED-F9P status. The location of the LEDs is shown in
Figure 7 below.

The RTK status LED provides an indication of the state of the ZED-FOP module RTK-STAT pin.

e At start-up the LED is off.

e When in RTK float mode, the yellow LED flashes at the navigation rate (1 Hz default). This is also
an indication that RTCM corrections are received.

e Whenin RTK fixed mode, the yellow LED is turned on.

The blue time pulse LED will flash at the default 1 Hz rate when the time solution is valid.

If activated, the Geofence status LED indicates the current Geofence status, i.e. in or outside a
designated area.

See the ZED-F9P Interface description [1] for help with configuring the time pulse output or activating
the Geofence pin.
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BATTERY

CHARGE

[n?‘ ZED-F9P time pulse LED
ROS

ZED-F9P RTK status LED

L
Figure 7: ZED-F9P LEDs

3.2.2 ODIN-W2 activity LED

ZED-F9P Geofence status LED

The ODIN-W2 module uses a multi-colored LED to show particular activity status. This is positioned

adjacent to the ZED-F9P reset switch and shown below in Figure 8. The activity status is summarized
in Table 1 below.

Mode Status LED color
Data mode, EDM IDLE Green
Command mode IDLE Orange
Data mode, Command mode, EDM CONNECTING Purple
Data mode, Command mode, EDM CONNECTED? Blue

Table 1: ODIN-W2 u-connectXpress software LED activity states and colors

ODIN-W?2 activity LED

20208
02 RIALINS2

xolq )

Figure 8: ODIN-W2 Activity LED position on C099-F9P board

3 On data activity, the active LED flashes.
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4 Using the C099-F9P

The C099-F9P is shipped with the latest HPG firmware for the ZED-F9P GNSS module. Information
on updating either module’s firmware is provided in section 7 Firmware update, if required.

4.1 Powering the board

The board can be powered from a variety of sources:

e The USB connection
e A 3.7V Li-Po Battery via a JST connector

e Anexternal 6-12 V DC source via a 2.1Tmm connector; center pin V+. Also, the included USB-to-DC

plug adapter cable can be used to provide an additional USB power source.

uUsB

EVH-(Q099-Fgb

D
e

e
\ $LD WER 4
wew u-blar e,

DC power jack

Li-Po battery connector

Figure 9: Power connections

g

R

WM

Figure 10: Typical single-cell 3.7 V Li-Po battery with JST connector

Follow all published safety advice for using bare cell Li-Po batteries while charging and protecting

them from mechanical damage. Fire risk can occur if the advice is not followed.

Ensure correct polarity on the JST battery connector. In case of an incorrect polarity, the incorrect
polarity LED will be on. Due to the polarity protection feature, the supply rails will not be powered.

UBX-18055649 - RO8 Using the CO99-F9P
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All supply connections are fed via a Schottky diode to the main supply bus to allow multiple sources
to be connected in parallel. The Li-Po battery will be charged from either the DC power source or the
USB power source. The charging status is indicated by a red LED which is on during charging and
turned off when fully charged.

When less than 500 mA is available from the USB host, ensure sufficient extra supply via the DC power
jack. Note that due to the higher current consumption caused by the battery charging it is not
recommended to charge the battery via USB only.

i Supplying through the USB port requires the power source (USB host) to support the USB
enumeration process. If the power source is not capable of enumeration, you may use the provided
USB-to-DC adapter cable and connect it to the DC plug. There is no current limitation for the DC

supply.

Red battery charge LED

Orange battery incorrect
polarity indicator LED

Figure 11: Battery charge status LED

4.1.1 Non-wireless operation

For use-case scenarios where non-wireless data link is needed the ODIN-W?2 can be disabled. In order
to disable the ODIN-W2, connect the safeboot jumper which forces the ODIN-W2 into safeboot mode
during the device start-up. See Figure 6 to locate the safeboot pins.

On average, the ODIN-W?2 consumes less current when started in the safeboot mode. In addition, the
safeboot mode ensures that no intentional radiation originates from the 2.4 GHz antenna connector.

4.2 GNSS RF input

The C099-F9P board should be used with the antenna supplied with the kit. If another active antenna
is used, be aware that the RF input has a bias output designed to supply 3.3 V DC with a 70 mA
maximum current load. A DC block is advisable if the board is connected to a signal distribution
scheme or GNSS simulator to prevent any potential shorting of the antenna bias.

SMA GNSS antenna connector

Figure 12: GNSS antenna connector

When using the supplied antenna it is advisable to use the ground plane provided. Otherwise ensure
that there is an adequate ground plane, e.g. by mounting in the center of a metallic car roof.

UBX-18055649 - RO8 Using the CO99-F9P Page 14 of 51
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Figure 13: The supplied GNSS multi-band antenna

4.3 User interfaces

The C099-F9P has a number of fixed connection options besides the wireless modes. There is also an
additional Arduino R3 / Uno interface for external host connection.

The USB connector on the board provides connection via an on-board hub providing:

e AnFTDIUSB bridge to ZED-FOP UART1 and ODIN-W2 UART COM ports.
e Dedicated connection to the ZED-FOP USB port.

4.3.1 FTDIUSB bridge

When the USB cable from the user’s PC is connected, a driver will load and set up two virtual serial
ports, as shown below in Figure 14. Additionally, a further serial VCP will be created to provide a direct
connection with the ZED-F9P USB port.

¥ Ensure that the PCis connected to the internet to load the drivers from Windows Update.

The first of these is connected to the ZED-F9P serial port and should be selected with u-center. The
second serial device is for the ODIN-W2 module when using s-center. In Figure 14 the ODIN-W2
connection is the first port (COM 62) and the ZED-F9P connection is the second port (COM 64). Port
numbering can be different between individual PCs, but the same arrangement applies.

4 "7 Ports (COM & LPT)
- .J3' C099 application board, ODIN-W2 (COMB2) ZED-F9P and ODIN-W2

..73" €099 application board, ZED-FIP (COMG4) COM ports installed

L 7 Communications Port (COM1)

Figure 14: Windows Device Manager COM port view

In addition, a third VCP will be created corresponding to the ZED-F9P USB port. Windows 10 users will
see a new VCP device in the Device Manager window as it will load an in-built driver. With older
Windows installations, a driver will be loaded via Windows Update. In this case the device will be
identified as a u-blox GNSS device in the Device Manager window.

Open u-center, select the ZED-F9P serial port, and set the baud rate to 460800 to match the ZED-
FOP default UART setting. Once connected, u-center shows typical received signal levels from
multiple GNSS bands, see Figure 15 below.
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Figure 15: u-center view with ZED-F9P connected

Additional UBX protocol messages can be enabled to view additional information in u-center. For
example, the following are typical messages the user can poll or enable for periodic update.

e NAV-HPPOSLLH
e NAV-RELPOSNED

e NAV-SIG

e NAV-SOL

e NAV-STATUS
e NAV-SVIN

For help with the Message view, see u-center User guide [3].

4.3.2 Bluetooth serial COM port connection

Before using Bluetooth ensure that the supplied Wi-Fi/Bluetooth antenna has been connected to the
SMA connector “ODIN-RF” to ensure correct operation of the wireless functions.

e Create the u-blox configuration file for the rover BT link. Use the “u-blox ODIN-W2 BT Rover.txt”
file listed in Appendix D. You can also download the file from Github: https://github.com/u-
blox/ublox-C099_F9P-uCS/tree/master/odin-w?2

e For information on how to upload configuration file using s-center, see section 6.1.1 Configuring
a C099-F9P rover for Wi-Fi operation.

On the PC, go to the Bluetooth setup and in the Windows Add a device window, add the ODIN-W?2
module as a device, identified as “ODIN-W2-XXXX”, by selecting ODIN-W2 and clicking Next. See
Figure 16 and Figure 17 below.
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() [ Add a device
Select a device to add to this computer
Windows will continue to lock for new devices and display them here.
- Other - Other
| Bluetooth | Bluetooth
== Other = Other
-~ Other =7 Other
| Bluetooth | EBluetooth
== Other = Other
. Other 7% ODIN-W2-7DCET1
| Bluetooth | Bluetooth
=  Other == Other
What if Windows doesn't find my device?

Figure 16: Windows 7 Add a device window shows ODIN-W2

==

) [ Add a device

Select a device to add to this computer

Windows will continue to lock for new devices and display them here.

o Other -7 Other
| Bluetooth | Bluetooth
== Other == Other
o Other -7 ODIN-W2-7DCB71
| Bluetooth | Bluetooth
= Other = Other

What if Windows doesn't find my device?

Figure 17: Click on the ODIN-W2 and select Next

You can locate the device by examining the Bluetooth connections under the Ports tab in the Windows
Device Manager. Search for a “Standard Serial over Bluetooth link” - usually the first one on the list.
Use this device for connecting the ZED-F9P to u-center.

HF

e ? Standard Senal over Bluetooth link (COMB4)
-‘? Standard Serial over Bluetooth link (COMBS)
-'? LSE Serial Port (COM24)
. ?' LSE Serial Port (COM3T)

Figure 18: Installed Bluetooth SPP port

The ODIN-W2 module communicates with the ZED-F9P via a serial port which is shared with the FTDI
USB/COM port via multiplexors. Once Bluetooth communication is established with the ODIN-W?2, a
jumper connection should be made at position “30E” to connect the serial ports of the ZED-F9P and
ODIN-W?2 together. See Figure 19 below.
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Jumper position “30E”

i ]
| M oz0000z08608
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Figure 19: C099-F9P rover jumper position

For information, Figure 20 below shows the C099-F9P logical connections for serial interfaces with
the “OE3” jumper set as required to connect the ODIN-W?2 and ZED-F9P serial ports.
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Figure 20: Schematic showing serial interface connection with jumper OE3 setting
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4.3.2.1 Windows OS issues with Bluetooth SPP

There are some known issues with the Windows Bluetooth Serial Port Profile (SPP) implementation
for Windows 7-10. Symptoms include the Bluetooth Virtual COM port not installing or applications
not connecting to the Bluetooth Virtual COM port. In other cases Windows might crash or become un-
responsive. This is not related to the ODIN-W2 Bluetooth implementation that uses the Bluetooth
standard SPP.

Figure 21: ASUS USB-BT400

A known industry fix is to not use the Windows Bluetooth stack and PC Bluetooth hardware. This is
done by using a USB Bluetooth adapter that uses its own Bluetooth stack. A device that is known to
work is the ASUS USB-BT400 (USB 2.0). Once installed use the Bluetooth Virtual COM port assigned
to this device and not the built-in Bluetooth.
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5 Rover operation using NTRIP

This section shows how the ZED-F9P is used as a rover using correction information provided over the
internet using NTRIP. This is usually provided by a host from a single reference station or as a Network
RTK Virtual Reference Service (VRS).

A suitable host is a PC with internet access. A host runs an NTRIP client and streams RTCM
corrections to the C099-F9P through a UART or Bluetooth connection. Messages transmitted
through a Bluetooth or Wi-Filink are forwarded to I2C bus and vice versa. The user is advised to enable
desired messages in both UART and 12C interfaces in ZED-F9P.

5.1 PC hosting via u-center

The u-center application includes an NTRIP client for PC hosting. The u-center User guide [3] provides
help when setting NTRIP service connections. Users can connect via Bluetooth for wireless operation
or directly via a serial COM port. Once the service is active, RTCM corrections are sent over the
connection and data can be logged as usual with u-center.

The u-center User guide [3] provides more information concerning NTRIP connections. Enter the
required connection settings using the client setting window show below.

MNTRIP client settings @I
MNTRIP caster settings
Address: | www.earefp.net
Port: | 2101
Username: ;
Password: | =======
NTRIP stream

Update source table
NTRIF mount point: | SHOEDOGBRO j Mount point details

™ Use manual position

Longitude {deg): | -0.20488
Latitude (deg): | 51.24186
Altitude (m): | 155

Geoid sep. (m): | 0

oK Cancel

Figure 22: u-center NTRIP client view

Ensure that the NTRIP client connection icon is green. This indicates a successful NTRIP connection
and that RTCM data is transferred to the CO99-F9P.

S

n.m

1.1
N

Ready =I= MTRIP client: fi.nrth.ew:9301

Figure 23: u-center NTRIP client communication indicator
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Confirm that the rover has obtained RTK fixed mode in the u-center Data view:

Longitude
La_tir de

Figure 24: u-center Data view RTK FIXED indication

5.2 Mobile hosting

A portable rover option is offered by an Android application which utilizes Bluetooth connection to a
single C099-F9P. An example application is provided by Lefebure and it is available from Google Play
Store: https://play.google.com/store/apps/details?id=com.lefebure.ntripclient.

RTK:16  Age: 01s

0.0 MPH

27,838 Bytes

10:27:34 Service Started

10:27:34 Device: SMART-MR10
10:27:34 Trying to Connect...
10:27:35 Bluetooth Device Connected

10:27:35 NTRIP: Waiting for GGA from
Receiver

10:27:35 Fix type is now RTK

10:27:35 Using 16 satellites

10:27:36 NTRIP: Connecting...
10:27:36 NTRIP: Connected to caster

Figure 25: Lefebure Android NTRIP client

5.3 Pairing the host with the CO99-F9P

For both options the user needs to pair the host (PC or mobile) with the C099-F9P ODIN-W?2 wireless
module.

Once paired the user can then attach the host application to the C099-F9P to send and receive data.

ZF See Section 4.3.2 Bluetooth serial COM port connection for pairing information.
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6 Reference station and rover pairing

This section is provided for users with two CO99-F9P boards and provides configuration information
when setting up a C099-F9P as a reference station to provide local RTCM corrections for a CO99-F9P
rover. This connection uses Wi-Fi connectivity to maximize range for untethered operation.

6.1 Wi-Fi connection between two C099-F9P boards

This set-up relies on establishing a peer-to-peer Wi-Fi connection between two C099-F9P boards for
short base-line applications, e.g. drones and the like.

Separate ODIN-W?2 configuration files are required to enable the reference station and rover CO99-
FOP boards to operate as an Access Point and client respectively. Ensure the ODIN-W?2 on the rover
and reference station runs the u-blox u-connectXpress software.

Prior to use, the reference station CO99-FI9P needs RTCM3 output messages enabled and its position
surveyed-in. When the device is surveyed-in, it will enable output of the RTCM3 1005 message to
enable the rover to begin RTK operation. Consult the Integration manual [2] for information relating
to reference station operation for more information.

In this example the CO99-F9P reference station sends corrections to a C099-F9P rover and the rover
transmits NMEA and UBX messages back to the base. The rover operation can be viewed remotely
with u-center connected to the reference station’s ODIN-W2 COM port.

Bidirectional peer-to-peer Wi-Fi link

v

A

Base

USB #1 ODIN-W2 port to u-center
for rover data

Figure 26: Reference and rover C099-F9P set up

The sub-sections below describe the steps required to configure the boards for Wi-Fi operation plus
the settings needed for rover and base operation.

6.1.1 Configuring a C099-F9P rover for Wi-Fi operation
The following steps provide guidance on configuring the CO99-F9P ODIN-W?2 Wi-Fi for rover operation:

¥ Disconnect any UART multiplexor jumper connections before proceeding.

e Connect the rover unit via USB to a PC.
e Install the u-blox s-center evaluation application.
e Open s-center which will show the following view:
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el s-center 4.0.0

Connection Type

@ Serial Compart Connection

() TCP Connection

Serial

COM Port COM3E
Baud Rate 460800
[Cata Bits 3

Parity Mone
Stop Bits 1

Flow Cantral Mane

Log COM Port COMI16
Log Baud Rate Mot in use

- 1100 +

Type TCP Client
Client IP 192.168.0.99
Port 8080

T Select Mode

w

Enter AT Mode after Open the Port

- Use DTR and DSR Pin for AT Mode

FTDI USE Driver Latency Timer

Current value is 1 ms
Update

AT Command Escape Sequence

Recommended is 1 ms

1100

Open Port ] l Cancel

Figure 27: s-center connection setting window

e Select the COM port installed for the ODIN-W2.

e Setthe baud rate to 460800 baud.

e Ensure hardware flow control is not enabled.

e Click on the “FTDI USB Latency Timer” Update button.

e Click Open Port.

e If the CO99-F9P is powered, the ODIN-W2 responds with AT commands.

Figure 28: s-center connected to ODIN-W2

UBX-18055649 - RO8

Reference station and rover pairing

@ s-center 400 - COM38 =8 Eon =<
File Settings Tools Help
Basic Connection | 9 Bluetooth Settings | Wy Wi-Fi Settings ff Advanced Connection and Settings | *____, User Defines| @b on
Find Devices Server Configuration N
Connection Status
Bluetooth Inquiry - - Bluetooth: -
- Address: -
Low Energy Discovery v M Wi-Fi: -
— . Remove | 5003 SSID: -
WA scan Ormn | o
Blugtooth | Low Energy | Wi-Fi Station | Wi-Fi Access Point | Ethernet | TCP/UDP | Bridge | Network| RSSE: -
0- - MNetwork Status
spp v spp://0012F3000001p [7] Defauit Peer [ Esc Enable 1- E State: -
2- = .
[7] Qos Enable ) B i
o - : i ] SR
Read Bonded Bond SLATES =
- Remove All Gateway: -
Prim, DNS: -
Peer Handle - [ EnterData  [] Startup Data | Connectionstatus | | Network Status | 1:; =
Console Window
*5.01-002"
ok Enable GUI
AT-UMLA=1
BKMLA:D4CAGETDC871 EVK-ODIN-W2 via ST-LINK
AT=UMLA=2 Firmware Update
~UMLAD4 CABETDCET2
oK =
AT-UMLA=3 h N
~UMLA:D4 CABETDCBT3 2, :
oK <’ o 2
AT ¥ | ODIN-W2 series at u-blox.com
[ cioseport | [ aTMoce | [ DatamMode | [ EDM moge | [ ppe moce | [patapump | [ smbps | [ Reset | [ cear | [ cetan | [ setan |
COMS38 460800 3-N-1 No Flow DSROff, DTROn  B:D4CAGETDCBTL  u-blox  ODIN-W2 Firmuare: 5.0.1-002
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Itis important to do a factory reset on the ODIN-W?2 before downloading a new configuration file. Click
the Factory button in the same window to perform a factory reset.

Store Factory
N—

| Defaut || Enablecur |

Figure 29: s-center factory reset button

After factory reset, the device will be set with a baud rate of 115200 baud with hardware flow control
enabled. You must change this to no hardware flow control:

e First set s-center to 115200 baud and no flow control.
e Open the COM port.
e Select EVK-ODIN-W2 via ST-LINK button as shown below to disable flow control.

Store H Factory ]

[ Derut | [ Enablecur |
[ Evk-oDIN-W2 via ST-UNK |
Firmware Up{ This will disable flowcontrol, ¢

MOTE: Flowcontrol in s-cente

=

o

ODIN-W2 series at u-blox.com

[ cetan | [ setan |

Figure 30: Resetting ODIN-W2 to no flow control

Click the AT Mode button to ensure it is responding correctly. You will see it respond with AT
commands if communication is OK.

Console Window

AT+=GMR

"5.0.1002"

oK

AT+UMLA=1
+UMLA: D4 CARETDCETL
oK

AT+UMLA=2
+UMLA: D4 CARETDCET2
oK

AT+UMLA=3
+UMLA: D4 CARETDCETS
oK

AT

Close Port | | ATMode | | DataMode | |

Figure 31: Clicking AT Mode button

Download the u-blox configuration file for the rover Wi-Fi link. Use the “Rover ODIN-W2 Access Point
UDP Server.txt” file listed in Appendix D. You can also download the file from Github:
https://github.com/u-blox/ublox-C099_F9P-uCS/tree/master/odin-w2

Select File > Download Configuration.
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@ s-center4.00 - COM38

Settings Tools Help

Download Configuration I

Save Configuration '_ Wi-Fi 3¢

Load User Defined AT Command guration

Save User Defined AT Command | (< UWAPI

Start a Mew s-center -

Exit j mode [=L
[T Z-WPEZ - TTIPSKE

NEAMVA MW O o

Figure 32: Selecting File > Download Configuration

Select the “Rover ODIN-W?2 Access Point UDP Server.txt” file and click Open.

v Libraries » Documents » C99 » C99 ODIM COMFIG » PEER TO PEER WIFI

/| Open ~ Print E-mail New folder

Documents library
PEER TO PEER WIF

= | Rowver ODIN-W2 Access Point UDP Server.txt

= || Base ODIN-W2 Station UDP client.txt

laces

m

Figure 33: Selecting file “Rover ODIN-W2 Access Point UDP Server.txt”

Disconnect s-center from the ODIN-W2 port and toggle the CO99-F9P off and on again to ensure it
will be using the new configurations as default.

Position a jumper as shown in Figure 20 to connect the ZED-F9P and ODIN UARTSs. This will enable
correction traffic from the rover and provide a return path for messages from the rover.

Connect the GNSS antenna, ensure use with the supplied ground plane and place in good GNSS
visibility conditions.

In order to prevent the ODIN-W2 from mistranslating NMEA and UBX streams, it is advisable to
reprogram the factory default escape sequence ‘+++’ as described in the AT command manual [5].

6.1.2 Configuring a C099-F9P reference station (Base) for Wi-Fi operation

The following steps describe setting up the C099-F9P ODIN-W?2 Wi-Fi for reference station operation.

¥ Disconnect any jumper connections before proceeding.

Follow the same process for configuration described above in section 6.1.1 Configuring a CO99-F9P
rover for Wi-Fi operation except load the reference station configuration file “Base ODIN-W2 Station
UDP client.txt” instead - see Appendix E for the file listing.

After this the CO99-F9P reference station will require setting up as shown below to enable sending
correction data to the rover.
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6.1.3 ZED-F9P reference station (Base) and rover configuration

With the latest version u-center, connect to the C099-F9P using the dedicated ZED-FOP USB
connection.

See section “Required configuration of the base and rover” in the ZED-F9P Integration Manual [2] for
details on configuring the required RTCM3 messages and setting the ZED-F9P as a reference station.
We provide easy-to-use configuration files to download, as detailed in the next section.

¥ Ensureall RTCM messages are set to transmit from UART1 and the baud rate is set to 460800,
otherwise the ZED-F9P and ODIN-W2 cannot communicate. Wrong settings can occur if the ZED-
FOP firmware is updated or the ZED-FOP UART1 is set to its default state.

¥ Ensure that the UART1 port protocols are set to “None” for input and “RTCM3” for output to
prevent input of the received rover messages.

¥ Place a jumper at position “OE3” as shown in Figure 19, this will connect the ODIN-W2 and ZED-
FOP UARTSs to provide transmission of RTCM messages to the rover.

6.1.3.1 Downloading Base ZED-F9P configuration file
Download the configuration files from: https://github.com/u-blox/ublox-C099_F9P-uCS

Or save the contents of Appendix F to a .txt file. Open u-center View > Generation 9 Configuration
View:

File Edit View Player Receiver Tools Window Help

DG Packet Console F6 a @
Binary Console F7

D= v [UU
Text Console 2 T
Messages View F9

Generation 9 Configuration View
/ Statistic View F10

Figure 34: u-center View > Generation 9 Configuration View

Select Advanced Configuration:

3 u-blox Generation 9 Advanced Configuration View

GNSS Configuration Item sort + - Search
Advanced Configuration -

@/

Figure 35: u-center View > Generation 9 Configuration View > Advanced Configuration
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Important next step — return receiver to defaults by selecting the icon in the Action toolbar (see
number 1 in Figure 36):

Click return to PRI o
! defaults button &Y =

Click autobaud or
select 38400 baud

Figure 36: Return receiver to defaults and select 38400 baud

Select Load to load the “FOP Base config C99.txt” file and Send to send the configuration:

O

Item writes ready to send to receiver

[ey [layer | vae

| | Click load
button
Load ditterences from default |
Set of configuration changes (Red duplicates ignored)
Items to delete
Key Layer

Remove Al

i Click Send
Send
— 1 button

Item writes ready to send to receiver

Figure 37: Load “F9P Base config C99.txt” file and click Send

Keep the USB connected to the PC, however disconnect u-center from the ZED-F9P USB port and
connect to the ODIN-W2 USB Virtual Com Port. This will allow viewing and logging of the rover CO99-
FOP message data via the return Wi-Fi link.

Connect the GNSS antenna, ensuring use with the supplied ground plane and place in good GNSS
visibility conditions.

Now load the “FOP Base Survey in start.txt” file in the same way, except do not return the receiver to
default settings, as we have a working configuration. It should carry out the Survey-In process and
then output all the required RTCM messages.

6.1.3.2 Downloading Rover ZED-F9P configuration file

Connect the Rover ZED-F9P via the dedicated USB connection.

Load and Send the “FOP Rover config C99.txt” file as shown in the previous section. Both units will
now be ready to operate. You would have previously downloaded it from the u-blox GITHUB repository,
or copied the contents of Appendix F to a .txt file.
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A Wi-Fi connection is established between reference and rover boards when the rover CO99-F9P is
powered up. The ODIN-W2 activity LED is set blue when the base and rover have connected and

flashes when data transfer is occurring. Look for acquisition activity shown in u-center to confirm the
rover is operating correctly.

Ensure that any rover ZED-F9P output messages and configurations required are set before
connecting the reference as this can only be done via the dedicated ZED-F9P USB connection.

Ensure that the configuration is saved to flash to avoid reverting to a default operation after power
cycling.

u-center will now show the rover GNSS information via the reference C099-F9P ODIN-W?2 connection:

[RF COM37 - urcenter 18.05.02 - [Messages - NMEA]
{81 Fle Edi View Player Recever Tooks Window Help
e O A
k) EDZO-E-BE-H- S Eisde0E@B
DE&~ -]
ol e 3% & @
. > -

| oy

= | a

f GuB ' [Fomz WMEATED
4 GaGGA (Giobl Positioning System Fi
" [ Hatina
K . Stareda
. = ach NMEA message

L ot ol  chaaiers betmesry
GNGLL (Geeguaphic Position - Laf | | ¥ ited 23 o characters epiesarting

£} GuGSA (GNSS DOP and Active Satellit

GHGSA (GNSS DOP and Active Ss

1 GHGSV (GNSS Satall
GAGSY (GNSS Satelia
pagel
paged

in View

5} GBGSW (GNSS Satellites in View)
pagel

page2
5 GLGSY (GNSS Sateltes i Vie]

Figure 38: u-center satellite signal view

Check that the rover has obtained a RTK Fixed mode in u-center Data view:

Longitude
Latitude

(IR
0.m

Figure 39: u-center Data view RTK FIXED indication
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7 Firmware update

This section shows how to update the GNSS and Wi-Fi/Bluetooth modules’ firmware if required.

The board is delivered with the latest versions of firmware running on the ZED-F9P and ODIN-W?2
modules. However, newer versions may become available during the lifetime of the product.

7.1 ZED-F9P firmware update

This section shows how to update the firmware and re-enable the configuration settings required for
the C099-F9P. The user has two possible serial communication channels to update ZED-F9P: UART1
and USB2.0 ports.

To update the ZED-F9P, connect to u-center via USB to the COM port identified as the ZED-F9P and
poll MON-VER to view the installed firmware: see Figure 14 for the Device Manager COM port view.
The shipped units will have HPG 1.12 firmware or newer. To download a new firmware follow the
sequence detailed below.

@ Messages - UBX - MON (Menitor) - VER ... | = = || &

UBX - MON {Manitor) - YER Version) 22s

Software Yersion
[EXT CORE 1.00 (554claf)

Harchware Version
|00130000

Extension(s)

ROM BASE 0xDD3IFEIGC
PWER=HPG 1.00B03
PROTWER=27.00
tOD=ZED-F49F
GPS.GLO.GALBDS
QZ55

@ | X A¥Pall | X & R

Figure 40: MON-VER poll response
To begin updating the firmware, select Tools > Firmware Update...

[@) File Edit View Player Receiver Window Help

T v U ow || ® A Firmware Update... Ctrl+U
Legacy Firmware Update...
AhE EDEDE-E e
Dump Receiver Diagnostics...
O &~ | u-blox 7/8/M8 Retrieve Log...
v lw oM & & o AssistMow Offline »
AssistNow Online 3
* - ;
GNSS Configuration...
[#- MMEA .
i File transfer... i
RTCM3 rsion)
- UBX Hotkeys...
- ACK (Acknowledge) Ereieseneee —
- AID (GPS Aiding) -1
@ CFG {Config) Hardware Yersion
- DBG (Debug) 00130000
- ESF (External Sensor Fusion Estension(s]
& HNR (High Navigation Rate] FIOM BASE DxCAAFEISC
INF (Information) Fw/VER=HPG 1.00A03R0Y
0G| qqer] PROTYER=27.00
B LOG (Datalogger) GPS.GLOGALEDS
B MGA (Multiple GMSS Assistance SBAS.0OZ5S

= MON (Monitor)

-~ BATCH (Data Batching]
EXCEPT {Exception Dump]
GINSS (Default System Settings)

Figure 41: Selecting u-center Firmware Update mode

The following Firmware image update window will appear:

UBX-18055649 - RO8 Firmware update Page 29 of 51



@biox

C099-F9P - User guide

Firmware image
[C:VaptopDataMaster Wy Documents P BO3 release\JUJU_ROX_v | =

Flash Information Structure (FIS) file / Flash Definiton Fie (FOF)

[V Enter safeboot before update

[V Use this baudrate for update
lqsoaoo v V' Send training sequence
I™ Use chip erase

™ Transfer image to RAM

Additional options

I

Command line

C:\Wsers\hunking\Desktop\ulnternal dev 21_2_2018\ubxfwupdate.exe -p STDIO -b 9600:9600: 460800 --no-fis 1
-5 1+t 1-v 1°C:\LaptopDataMaster\My Documents\F9P BO3 release
VJUIU_ROX_100_HPG 100803_TL2025.c410f17597f6c6747a299dc Sac86fc3f.bin”

Figure 42: Selecting u-center Firmware image folder

Receiver generation: Reserved

Firmware file: Present : 15/05/2018 17:33:31 (1.4 weeks ago)

Fis file: Not needed

Fimware wtilty: Present (C:\Users\hunking\Desktop\uintemal dev 21_2_2018\ubxfwupdate exe)
Connection: Connected

At the top is the Firmware image file selection window. Click on the button to the right of the window.
This allows you to select the folder and file. Select the new firmware image bin file.

Set the Enter safeboot before update and Send training sequence options. Set the Use this baudrate
for update option and select e.g. 460800 from the pull-down list. This is shown in Figure 43 below.

[V Use this baudrate for update

| 460800 |

[V Send training sequence
™ Use chip erase
™ Transfer image to RAM

[V Enter safeboot before update

Figure 43: Setting the required baud rate, safeboot and training sequence options

Then click the GO button at the bottom left corner of the window to begin the download.

<
LU

leady

Figure 44: Click GO for firmware update

The firmware update progress indication is shown adjacent to the input window.
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£} Firmware Update Utility =R EoR
Firmware image Receiver generation: Reserved
[ iV 1W-blox W 100 HPG 100 ZED-F9P \UBX_F9_100_HPG_100_ — | J = Fimnware file: Present : 31/10/2018 10:30:27 (2.2 days ago)
Flash Information Structure (FIS) file / Flash Definiton File (FDF) Fis file: Not needed

[ v tu-center-v 15;

Internalfashorl J J Firmware utilty: Present (C:\LaptopDataMaster\My Documents'wv 18.10_extem
Comnection: Connected
W Use this baudrate for update W Enter safeboot before update.

230400 < J¥ send training sequence

r ¥ Use chip erase

™ Transfer image to RAM

Additional options

Command ine

C:\LaptopDataMaster My Documents\v 18, 10_external_release\ubxfiwupdate, exe -p STDIO b
230400:9600:230400 -no-fis 1 C 15 1 -t 1-v 1 "C:\SVN1lu-blox FW 100 HPG100 ZED-FoP
\UBX_F5_100_HPG_100_7ED_F9P. 2609bfb50d3e6e832f55c 1eBed803ce8.bin”

[Write ACKfor packet 2066 -
54.5 Wiiing marker for the file system to speed up first initialization

546 Verfying Image on hardwars
[Wirie ACK for packet 2067

[Wite ACK for packet 2068

Wirie ACK for packet 2069

Wrte ACK for packet 2070

565 CRC check SUCCESS

565 Rebooting reciver

56.5 Firnware Update SUCCESS

Fimwere Update Utiity completed successfully

Exit code (0)
< b
@ @ ur

Figure 45: Programming progress and completion message

When programming is complete, the module will start up in a default configuration in which the ZED-
FOP serial port is set to 38400 baud. This requires changing to 460800 baud to provide sufficient data
bandwidth and work correctly with the ODIN-W2 module. In order to make the baud rate change
persistent follow the instructions in the figure below.

D Messages - UBX - CFG (Config) - VALSET (Mew Configuration) EI@

- NA (Mavigation Expert 5)
thavigation Bxper * | UEX-CFG (Corfig) - VALSET [New Configuiation] &
MEA Protocol)
(Odometer/Low-Speed COG filter) . §
- PM (Power Management) Eonpeeeleleny Détalls
p stended Power Management) Title The baud rate that should be configured on the
wer Vianag ! Group |CFG-UAF|T1 j LIART
- PMS (Power Management Setup)
- PRT (Ports) Key name |EFG-LIAF|T1-BAUDF|ATE ﬂ Dezcription
PWR (Power)
RATE (Rates) Key D 40620001 Add to List Type: U4
V (Remote Inventory)
y Canfiguration changes to send
Key Key D Type | Walue
CFG-UART1-BAUDRATE 040520001 U4 460800 Ox70800
Remove
Femove &l
w Configuration) Value
[ ESF (External Sensor Fusion) Walue hex
- HNR (High Navigation Rate)
. INF (Information) Jas0a0] 70800
[ (Data Logger) -
- I ultiple GNSS5 A ce)
- onitor)
M-I Layers Transaction
BR ¥ Flash [~ BER ¥ AAM No nansaction -
[ = v

W
|

Erllc

bl

Figure 46: Setting ZED-F9P UART 1 back to 460800 baud and saving it to flash memory

7.2 ODIN-W2 firmware update

Users have a choice of running two distinct firmware variants in ODIN-W2. By factory default the
ODIN-W2 on a C099-F9P runs a dedicated Mbed application firmware.
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7.2.1 Mbed OS 3 application firmware

The latest released binary is available via the u-blox git-hub repository:
https://github.com/u-blox/ublox-C099_F9P-mbed-3

Firmware update on ODIN-W?2 is possible by the following tool set:

e Through ODIN-W2 UART1 by using stm32flash.exe

It is recommended to download the stm32flash.exe command line tool from STM website or from
Sourceforge: https://sourceforge.net/projects/stm32flash/

Place the downloaded stm32flash executable in the same folder with the FW binary and check for a
correct ODIN-W2 COM port number in the Device Manager (Windows users).

To ensure no settings persist over the firmware versions, it is recommended to revert to factory
default before uploading a new firmware.

Prior to firmware upload, the ODIN-W2 must be started in safeboot mode. Proceed by placing a
safeboot jumper and reboot CO99-F9P. Location of the safeboot pin header and the reset button is
depicted in Figure 6. To confirm the ODIN-W2 started in safeboot mode the ODIN-W2 activity LED
remains off. Use the following command structure in power shell or command prompt to start the
FW upload:

\stm32flash.exe -b 115200 -w <c099mbed3.bin> -S 0x8000000 COM<port number>

To confirm a successful FW upload remove the safeboot jumper and restart the device. The ODIN-
W2 activity LED lights up.
EN Windows PowerShell

PS C:\> _\stm32flash.exe 115200 c099mbed3_v1.1.0.bin 0x8000000 com?
stm32flash 0.5

http: //stm32flash.sourceforge.net/

Using Parser : Raw BINARY
Interface 5er1a1 _w32: 115200 8E1l
fersion 0x31
Option 1 - 0x00
Option 2 : 0x00
Device ID : Ox0419 (STM3Z2F42xxx/43xxx)
: 192kiB  (12288b reserved by bootloader)
: 2048KiB (size first sector: 1x16384)
- Option RAM : 65552b
- System RAM : 30KiB
rite to memory
Erasing memory
rote address 0x08078500 (40.33%

Figure 47: Power shell capture of FW upload

7.2.2 u-connectXpress software
To utilize the standard ODIN-W2 connectivity stack, a firmware update is required.

The latest u-blox u-connectXpress software and related documentation is available via u-blox.com:
https://www.u-blox.com/en/product/odin-w2-series

It is recommended to download the stm32flash.exe command line tool from STM website or from
Sourceforge: https://sourceforge.net/projects/stm32flash/
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The software upload procedure consists of two consecutive phases. First, you must upload a
bootloader, but prior to the bootloader upload, you must restart the ODIN-W2 in safe boot mode.

Proceed by placing a safe boot jumper and reboot the C099-F9P. The location of the safe boot pin
header and the reset button is depicted in Figure 6: Switches and LEDs.

Continue with the bootloader upload:

.\stm32flash.exe -b 115200 -w <ODIN-W2-BOOT.bin> -S 0x8000000 COM<port number>
The actual connectivity software shall be uploaded while the ODIN-W?2 is still in safe boot mode.
Ensure correct memory indexing by incrementing the memory argument as shown below:

\stm32flash.exe -b 115200 -w <ODIN-W26X-SW.bin> -S 0x8010000 COM<port number>

EN Windows PowerShell

PS C:\> .\stm3?flash.exe 115200 ODIN-WZ2-BOOT-v0.8.2.bin 0x8000000 com/
stm32flash 0.5

http: //stm32flash.sourceforge.net/

Using Parser : Raw BINARY
Interface 5e|1a1 _w32: 115200 8E1

/ersion 0x31

Option 1 : 0x00

Option 2 : 0x00
Device ID : Ox0419 (STM32F42xxx/43xxx)

- RAM : 192kiB  (12288b reserved by bootloader)
- Flash : 2048KiB (size first sector: 1x16384)
- Option RAM : 65552b

- System RAM : 30KiB

rite to memory
Erasing memory

rote address 0x08002914 (100.00%) Done.

PS C:\>

Figure 48: Power shell capture of bootloader upload

EXN Windows PowerShell

PS C:%\> .\stm32ftlash.exe 115200 ODIN-W26X_FW5.0.1-002.bin 0x8010000 com/
stm32flash 0.5

http://stm32flash.sourceforge.net/

Using Parser : Raw BINARY
Interface 5e|1a1 _w32: 115200 8E1

fersion 0x31

Option 1 . 0x00

Option 2 : 0x00
Device ID : Ox0419 (STM32F42xxx/43xxx)

- RAM : 192KkiB  (12288b reserved by bootloader)
- Flash : 2048KiB (size first sector: 1x16384)
- Option RAM : 65552b

- System RAM : 30KiB

rite to memory
Erasing memory

rote address 0x0804al100 (15.78%)

Figure 49: Power shell capture of connectivity software upload

Once the connectivity software is uploaded successfully, the ODIN-W2 will be set with a baud rate of
115200 baud with hardware flow control enabled. You must change this to no hardware flow control
and set the ODIN-W2 UART baud rate to 460800 to ensure sufficient link bandwidth.
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To proceed, restart the ODIN-W2 in a normal boot mode by removing the safeboot jumper and
pressing the RESET button.

e Sets-centerto 115200 baud and no flow control.

e Open the COM port.

Select EVK-ODIN-W2 via ST-LINK button to disable flow control as shown in Figure 30.

Navigate to “User Defines” AT command tab, as shown in Figure 50.

B s-center 46.2 - COM24 - O X
File Settings Tools Help
Basic Connection 9 Bluetooth Settings () Wi-Fi Settings T..:f Advanced Connection and Settings 4,;, User Defines oblox
User Defined AT Commands
C ction Stat
Execute ||AT—UMRS=460300,2,3,1,1,0 | Execute || | onnection status
Bluetooth: -
Execute | |AT&W | Execute | | | Address: -
Wi-Fi: -
Execute ||AT—CPWROFF | Execute || | SSID: -
BSSID: -
Execut: | Execut: |
Heoe | | Heote | | Channel: -
Execute || | EEe || | ™ RSSk-
Execute | | Execute || | Metwork Status
State: -
Execute || | Execute || | Interface: -
IP Address: -
Ereiio || | Execute | Load | Save | Subnet: -
Gateway: -
Prim. DMNS: -
Console Window Sec. DNS: -
1Pvé: -
5.0.1-0027,"ODIN-W26X-5.0,1-002-0-gf4be84f 002" ~
oK
Store | Factory |
AT=GMR
“5.0.1-002°
oK Default | Enable GUI |
AT+UMLA=1 .
~UMLA:DACAGETETDF EVK-ODIN-W2 via ST-LINK |
OK
AT+UMLA=2 Software Update |
=UMLA:DACAGETETDF2
OK
AT=UMLA=3
+UMLA:DACABETETDF3
OK
v
AT V| ODIN-W2 series at u-blox.com
Close Port | AT Mode | Data Mode EDM Mode PPP Mode Data Pump 3 Mbps Reset | Clear | Get All | Set All
COM24 460800 8-N-1 Mo Flow  DSR Off, DTR On E:D4CABETETDF u-blox ODIN-W2 Software Version: 5.0.1-002

Figure 50: Set baud rate
Execute the following command set sequentially:

e AT+UMRS=460800,2,8,1,1,0
e AT&W
e AT+CPWROFF

Finally, adjust s-center baud rate to match 460800 by closing and opening the UART port.

Click the AT Mode button to ensure it is responding correctly. You will see it respond with AT
commands if communication is OK.
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Console Window

AT+GMR

"5.0.1-002°

OK

AT+UMLA=1
+UMLA:D4CABETDCETL
OK

AT+UMLA=2
+UMLA:D4CABETDCET 2
OK

AT+UMLA=3

+UMLA:D4 CASETDCETS
OK

AT

| closeport | [ ATMode || DataMode | |

Figure 51: Clicking AT Mode button

Download a u-blox configuration file for the ODIN-W2 module. The “u-blox ODIN-W2 BT Rover.txt” file
is the default configuration file shipped with the CO99-F9P. See Appendix C for configuration file
resources.

@ s-center4.00 - COM38

Settings  Tools  Help

Download Configuration ————
—— } Wi-Fi Se
Save Configuration
Load User Defined AT Command éuratinn |
Save User Defined AT Command | (= LUWAPI
Start a Mew s-center -
Exit { mode (=L
TTPRT ¥ T-PsE
Figure 52: Selecting File > Download Configuration
e Open
Q.\;; [+ Libraries » Documents » MyDocuments » C99 » C99 ODIN CONFIG
Organize » MNew folder
X Favorites ~  Documents library
B Desktop 99 ODIN CONFIG

4 Downloads
3 Documents

|| ublox ODIN BT Rower.bt

Figure 53: Selecting “u-blox ODIN-W2 BT Rover.txt” file

Select the file and click Open. It will download the file and write it to flash.

¥ The ODIN-W2 UART will now be set to 460800 baud in Data default mode. It will be ready for use
again.

Disconnect s-center from the ODIN-W2 port and power the C099-F9P off and on to ensure it will be
using the new configurations as default.

Position a jumper at “OE3” for Bluetooth operation.
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The rover is now ready to connect to PC or Mobile via Bluetooth SPP.
The board is now ready to use for the wireless connection examples described in the earlier sections.

When untethered operation is not required, the ZED-F9OP dedicated USB connection on the CO99-F9P
can be used for supplying corrections and monitoring or logging purposes with u-center.
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8 Arduino header connections

The board size and four connectors comply with the Arduino R3/Uno mechanical specification. The
functions of each I/O align as much as possible to the Arduino-specified functions. Check the pin
functions before using with an Arduino R3/Uno; see Figure 55 below. All the pin functions besides

power are 3.3 V compliant.

J9, Arduino D

J8, Arduino C

Figure 54: C099-F9P Arduino connectors

FRODUINO 2IN HAEALERS

J3, Arduino B

J2, Arduino A

BROUTNG &1

JIND A HEADER.

POLMER PINS: SESZ7T_Ns SEFEBODOT_MN COTM UA=T =RPT I2C
S5-12J
e - - CON_ELE ARIUING ETANDARD
ARDJING STENDSRD | M3 SRR WEHLARD Jg PIN ARRENGINMENT:
N SRRANGEFERT: N2 -
ATN i - MOD_PUR_EN L .
143 REF H hil I e
RESET_N | g) . & FESET b o~ b ‘-(g Deg
3 W oUT n - H 4 J_U
Saeur b s — n Y
e i a>——- - s i Die
o 120 =7 6D
a> L ] i<8 | AaRFF
IR R4 -ARER 3SR - - 10§ g?n g:(l'lQ
S0 1A= T 'K uuau—ur aszamie : i
‘lDTF _l A —F watstors || T L TLTLTLT.T USKHELS—Aa8E 36 3

ES3-188-33-T-3

urz

N
UERHET - B0eanLE

’ \
:_.
Daa_'csmrmolmu:s e
NNNNNN o
L 4
CG24@~LE-185. 16V

MOTE! PLACE THE UARISTORS
MEfR THE ARDUINC C HERDESR.

U3XhE7-2eeee 18

AROUTNG_E: AROLTNG _D: _ _ _
QOOTIM F"];s ED Z 0 DS _LERT LUART1 ZED: 770 T-05,USRT1I ODIN RX
ZED TX-READY, OOTN LART3
AROUING STAMIARD = ARDUING STADSAD
PIN Q«W:EE“\ENT d3con o5 J9  PIN ARRERGIFENT
eoel 1 - P
ADIi 2 e T _—H0-2E0-AR0 R
235; 3 3] INT 3x0_onIN_ARD H ‘g Dez
AD: 45 & --0-SED_CDIK TInCPu. 3l D5 ;\S?
= 54 ¥ g [r-PEADY_ZED T s — s | DB
INT SATZEOOT_N_ZEC b _:(E G
N TATINTA_ZED ] e AT
"T ™ =" .I JAXHF£—AARAF 367

5 \5;\ Y \:{f\\\z\ ESa-188-33-T-%

JBXHB7-208028_2
CGOABM_E-18CG. 1By
NOTZ: PLACE THE LPRISTIRS
NERR THE ARDUING C -ERADER.

Figure 55 C099-F9P Arduino R3 connections
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Appendix
A Glossary

Abbreviation Definition

FW Firmware

Li-Po Lithium polymer

NTRIP Networked transport of RTCM via internet protocol
RTK Real time kinematic

UART Universal asynchronous receiver transmitter

USB Universal serial bus

uTC Coordinated universal time

\VVCP Virtual COM port

Table 2: Explanation of the abbreviations and terms used

B Resources

Applicable configuration files are available in u-blox Github:

https://github.com/u-blox/ublox-C099_F9P-uCS

C u-blox ODIN-WZ2 BT Rover.txt

Copy all the text below this line into a text file named “u-blox ODIN-W?2 BT Rover.txt”.

AT+UBTLN="ODIN-W2-xxxx"
AT+UBTLC=000000
AT+UBTCM=2
AT+UBTDM=3
AT+UBTPM=2
AT+UBTMSP=1
AT+UBTLE=0
AT+UBTSM=1
AT+UNHN="ODIN-W2-200036001551373333393539"
AT+UDDRP=0,"", 0
AT+UDDRP=1,"",0
AT+UDDRP=2,"", 0
AT+UDDRP=3,"", 0
AT+UDDRP=4,"",0
AT+UDDRP=5,"", 0
AT+UDDRP=6,"", 0
AT+UWSCA=0, 4
AT+UWSC=0,0,0
AT+UWAPC=0, 4
AT+UWAPC=0,0,0
AT+UWAPC=0,2,""
AT+UWAPC=0,4,1
AT+UWAPC=0,5,2,2
AT+UWAPC=0,100,1
AT+UWAPC=0,106,1
AT+UWSC=0,0,0
ATS2=43

ATS3=13

ATS4=10

ATS5=8
AT+UDCFG=0, 1
AT&S1

AT&DO
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ATE1

AT+UBTCFG=1,1
AT+UBTCFG=2, 1
AT+UBTCFG=3, 56602
AT+UBTCFG=4,127
AT+UBTCFG=5, 0
AT+UBTCFG=6, 0
AT+UBTCFG=7,2000
AT+UBTCFG=8, 0
AT+UBTCFG=9, 0
AT+UBTLECFG=1, 1600
AT+UBTLECFG=2,2000
AT+UBTLECFG=3, 7
AT+UBTLECFG=4, 24
AT+UBTLECFG=5, 40
AT+UBTLECFG=6, 0
AT+UBTLECFG=7,2000
AT+UBTLECFG=8, 5000
AT+UBTLECFG=9, 48
AT+UBTLECFG=10, 48
AT+UBTLECFG=11, 24
AT+UBTLECFG=12, 40
AT+UBTLECFG=13, 0
AT+UBTLECFG=14,2000
AT+UBTLECFG=15, 5000
AT+UBTLECFG=16, 48
AT+UBTLECFG=17, 48
AT+UBTLECFG=18,24
AT+UBTLECFG=19, 40
AT+UBTLECFG=20, 0
AT+UBTLECFG=21, 2000
AT+UBTLECFG=22, 5000
AT+UBTLECFG=23, 48
AT+UBTLECFG=24, 48
AT+UBTLECFG=25, 0
AT+UMSM=1
AT+UMRS=460800,2,8,1,1,1
AT&W

AT+CPWROFF
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D Rover ODIN-WZ2 Access Point UDP Server.txt

Copy all the text below this line into a text file named “Rover ODIN-W?2 Access Point UDP Server .txt”.

AT+UWAPCA=0, 4
AT+UWAPC=0,0,1
AT+UWAPC=0, 2, UBXWifi
AT+UWAPC=0, 4,1
AT+UWAPC=0,5,1,1
AT+UWAPC=0,100,1
AT+UWAPC=0,101,192.168.0.10
AT+UWAPC=0,102,255.255.0.0
AT+UWAPC=0,103,192.168.0.1
AT+UWAPC=0,104,0.0.0.0
AT+UWAPC=0,105,0.0.0.0
AT+UWAPC=0,106,1
AT+UWAPCA=0, 1
AT+UWAPCA=0, 3

AT+UWCFG=1, 0
AT+UDSC=1,2,5003,1
AT+UMSM=1
AT+UMRS=460800,2,8,1,1,0
AT&DO

AT&W

AT+CPWROFF

E Reference station ODIN-W2 UDP client.txt

Copy all the text below this line into a text file named “Base ODIN-W?2 Station UDP client.txt”.

AT+UWSCA=0, 4
AT+UWSC=0,0, 1
AT+UWSC=0, 2, "UBXWifi"
AT+UWSC=0,5,1
AT+UWSC=0,100,2
AT+UWSCA=0, 1
AT+UWSCA=0, 3
AT+UWCFG=1, 0

AT+UMSM=1

AT+UDDRP=0, "udp://192.168.0.10:5003",2
AT+UMRS=460800,2,8,1,1,0
AT&DO

AT&W

AT+CPWROFF
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F FOP Base config C99.txt

Copy all the text below this line into a text file named “FOP Base config C99.txt.

# Config changes format version 1.0

# created by u-center version 18.11 at 11:37:53 on Tuesday, 08 Jan 2019
[del]

[set]

RAM CFG-UART1INPROT-NMEA O # write value 0 to item id 10730002
Flash CFG-UART1INPROT-NMEA O # write value 0 to item id 10730002
RAM CFG-UART1INPROT-RTCM3X 0 # write value 0 to item id 10730004
Flash CFG-UART1INPROT-RTCM3X 0 # write value 0 to item id 10730004
RAM CFG-UART1OUTPROT-UBX 0 # write value 0 to item id 10740001
Flash CFG-UART1OUTPROT-UBX 0 # write value 0 to item id 10740001
RAM CFG-UART1OUTPROT-NMEA O # write value 0 to item id 10740002
Flash CFG-UART1OUTPROT-NMEA 0 # write value 0 to item id 10740002
RAM CFG-UART1OUTPROT-RTCM3X 1 # write value 1 to item id 10740004
Flash CFG-UART1OUTPROT-RTCM3X 1 # write value 1 to item id 10740004
Flash CFG-UART1INPROT-UBX O # write value 0 to item id 10730001
RAM CFG-UART1INPROT-UBX O # write value 0 to item id 10730001

0x1 to item id 209102be
Ox1 to item id 209102be
Ox1 to item id 2091035f
Ox1 to item id 2091035f
Ox1 to item id 20910364
Ox1 to item id 20910364
Ox1 to item id 2091036e
0x1 to item id 2091036e
0x5 to item id 20910304
0x5 to item id 20910304
0x1 to item id 209102cO0
Ox1 to item id 209102c0
Ox1 to item id 20910361
Ox1 to item id 20910361
Ox1 to item id 20910366
Ox1 to item id 20910366
Ox1 to item id 20910370
Ox1 to item id 20910370
0x5 to item id 20910306
0x5 to item id 20910306
Ox1 to item id 20910369
Ox1 to item id 20910369
Ox1 to item id 2091036b
Ox1 to item id 2091036b

write value
write value
write value

RAM CFG-MSGOUT-RTCM 3X TYPE1005 UART1 0xl
Flash CFG-MSGOUT-RTCM 3X TYPE1005 UART1 0xl
RAM CFG-MSGOUT-RTCM 3X TYPE1074 UART1 0xl
Flash CFG-MSGOUT-RTCM 3X TYPE1074 UART1 0xl
RAM CFG-MSGOUT-RTCM 3X TYPE1084 UART1 Oxl
Flash CFG-MSGOUT-RTCM 3X TYPE1084 UART1 0xl
RAM CFG-MSGOUT-RTCM 3X TYPE1124 UART1 Oxl
Flash CFG-MSGOUT-RTCM 3X TYPE1124 UART1 0xl
RAM CFG-MSGOUT-RTCM 3X TYPE1230 UART1 0x5
Flash CFG-MSGOUT-RTCM 3X TYPE1230 UART1 0x5
RAM CFG-MSGOUT-RTCM 3X TYPE1005 USB 0xl
Flash CFG-MSGOUT-RTCM 3X TYPE1005 USB 0xl
RAM CFG-MSGOUT-RTCM 3X TYPE1074 USB 0xl
Flash CFG-MSGOUT-RTCM 3X TYPE1074_ USB Oxl
RAM CFG-MSGOUT-RTCM 3X TYPE1084 USB 0x1
Flash CFG-MSGOUT-RTCM 3X TYPE1084 USB Oxl
RAM CFG-MSGOUT-RTCM 3X TYPE1124 USB 0xl
Flash CFG-MSGOUT-RTCM 3X TYPE1124 USB 0x1
RAM CFG-MSGOUT-RTCM 3X TYPE1230 USB 0x5
Flash CFG-MSGOUT-RTCM 3X TYPE1230 USB 0x5
RAM CFG-MSGOUT-RTCM 3X TYPE1094 UART1 0xl
Flash CFG-MSGOUT-RTCM 3X TYPE1094 UART1 0xl
RAM CFG-MSGOUT-RTCM 3X TYPE1094 USB 0x1
Flash CFG-MSGOUT-RTCM 3X TYPE1094 USB 0x1

S

write value
write value
write value
write value
write value
write value
write value
write value
write value
write value
write value
write value
write value
write value
write value
write value
write value
write value
write value
write value
write value

S oS e S S S S S S S S o o o o e e S o S o o o o = 3 o
FRPRPRPRPRPRPRPRPRPRPOORRRPRPRPRERRRPRRPROORRRRRRRPR

RAM CFG-MSGOUT-UBX NAV PVT USB 0xl write value Ox1 to item id 20910009
Flash CFG-MSGOUT-UBX NAV PVT USB Ox1 write value 0x1 to item id 20910009
RAM CFG-MSGOUT-UBX NAV SVIN USB 0xl1 write value Ox1 to item id 2091008b
Flash CFG-MSGOUT-UBX NAV SVIN USB 0x1 write value 0x1 to item id 2091008b
Flash CFG-UART1-BAUDRATE 0x70800 # write value 460800 0x70800 to item id 40520001
RAM CFG-UART1-BAUDRATE 0x70800 # write value 460800 0x70800 to item id 40520001
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G F9P Rover config C99.txt

Copy all the text below this line into a text file named “FOP Rover config C99.txt.

# Config changes format version 1.0
# created by u-center version 18.11 at 11:16:51 on Tuesday, 27 Nov 2018
[del]
[set]
RAM CFG-UART1INPROT-UBX 1
Flash CFG-UART1INPROT-UBX 1
RAM CFG-UART1INPROT-NMEA O
Flash CFG-UART1INPROT-NMEA O
RAM CFG-UART1INPROT-RTCM3X 1
Flash CFG-UART1INPROT-RTCM3X 1
RAM CFG-UART1OUTPROT-UBX 1
Flash CFG-UART1OUTPROT-UBX 1
RAM CFG-UART1OUTPROT-NMEA 1
Flash CFG-UART1OUTPROT-NMEA 1
RAM CFG-UART1OUTPROT-RTCM3X 0 write value
Flash CFG-UART1OUTPROT-RTCM3X 0 write value

# to item id 10730001
#
#
#
#
#
#
#
#
#
#
#
RAM CFG-USBINPROT-UBX 1 # write value
#
#
#
#
#
#
#
#
#
#
#
#

to item id 10730001
to item id 10730002
to item id 10730002
to item id 10730004
to item id 10730004
to item id 10740001
to item id 10740001
to item id 10740002
to item id 10740002
to item id 10740004
to item id 10740004
to item id 10770001
to item id 10770001
to item id 10770002
to item id 10770002
to item id 10770004
to item id 10770004
to item id 10780001
to item id 10780001
to item id 10780002
to item id 10780004

write value
write value
write value
write value
write value
write value
write value
write value
write value
write value

Flash CFG-USBINPROT-UBX write value
RAM CFG-USBINPROT-NMEA write value
Flash CFG-USBINPROT-NMEA
RAM CFG-USBINPROT-RTCM3X
Flash CFG-USBINPROT-RTCM3X
RAM CFG-USBOUTPROT-UBX
Flash CFG-USBOUTPROT-UBX
Flash CFG-USBOUTPROT-NMEA
RAM CFG-USBOUTPROT-RTCM3X 0

write value
write value
write value
write value
write value

el el el e

write value
write value

ORrRPRRPRPRPREPREPRLPRPLPOORRREREREROOLR R

Flash CFG-USBOUTPROT-RTCM3X 0 write value O to item id 10780004
Flash CFG-UART1-BAUDRATE 0x70800 write value 460800 0x70800 to item id 40520001
RAM CFG-UART1-BAUDRATE 0x70800 write value 460800 0x70800 to item id 40520001

H C099-F9P antenna specification

H.1 Wi-Fi/Bluetooth antenna specification

EX-IT WLAN RPSMA / Ex-IT WLAN SMA

Manufacturer ProAnt

Type ¥% wave dipole dual-band antenna
Polarization Vertical
Gain +3 dBi

Impedance 500

Size 107 mm (straight)
Type Monopole
Connector Reverse polarity SMA plug (inner thread and pin receptacle)
SMA plug (inner thread and pin)
Comment To be mounted on the U.FL to SMA or reverse polarity SMA adapter cable
Approval FCC, IC, RED, MIC, NCC, KCC*, ANATEL, and ICASA

Table 3: Wi-Fi/Bluetooth antenna

ZF The variant included in the CO99-F9P kit is with SMA connector and has to be mounted on the
corresponding antenna connector of the C099-F9P board if you wish to use Wi-Fi or Bluetooth
connectivity.
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| Mechanical board dimensions
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Figure 56: C099-F9P rev. E dimensions
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J C099-F9P schematics

The following pages show the complete schematic for the CO99-F9P evaluation board.
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Related documents

ZED-F9P Interface description, doc. no. UBX-18010854

ZED-F9P Integration manual, doc no. UBX-18010802

u-center User guide, doc. no. UBX-13005250

u-blox GNSS Sensor and VCP Device Driver User guide, doc. no. UBX-15022397
u-blox Short Range Modules AT Commands Manual, doc no. UBX-14044127
s-center: https://www.u-blox.com/en/product/s-center

ANN-MB series multi-band GNSS antennas Data sheet, doc.no. UBX-18049862

(1]
(2]
(3]
(4]
(5]
(6]
(7]

=

C099-F9P - User guide

For regular updates to u-blox documentation and to receive product change notifications, register
on our homepage (www.u-blox.com).

Revision history

Revision Date Name Comments

RO1 10-Jul-2018 ghun/byou Initial release.

RO2 19-Oct-2018 byou Updates for the CO99-F9P rev. B board revision.

RO3 09-Jan-2019 olep Updates for FW upload procedure for ODIN-W2.

RO4 21-Feb-2019 olep Updated Arduino J9 schematics. Polarity requirement of the battery
connector.

RO5 25-Sep-2019 jhak/jjus Updates for the CO99-F9P rev. C board revision.

RO6 07-Nov-2019 jhak Updates for the CO99-F9P rev. E board revision.
Connectivity SW renamed u-connectXpress.

RO7 05-Dec-2019 mala Improved the quality of the schematics drawings.

RO8 09-Apr-2020 jhak/mala Added a missing step about selecting EVK-ODIN-W?2 via ST-LINK in section

UBX-18055649 - RO8

“u-connectXpress software”.
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Contact

For complete contact information, visit us at www.u-blox.com.

u-blox Offices

North, Central and South America

u-blox America, Inc.

Phone: +1 7034833180
E-mail: info_us@u-blox.com
Regional Office West Coast:
Phone: +1408573 3640
E-mail: info_us@u-blox.com
Technical Support:

Phone: +17034833185
E-mail: support@u-blox.com

UBX-18055649 - RO8

Headquarters
Europe, Middle East, Africa

u-blox AG
Phone: +41447227444
E-mail: info@u-blox.com

Support: support@u-blox.com

Contact

C099-F9P - User guide

Asia, Australia, Pacific

u-blox Singapore Pte. Ltd.

Phone: +656734 3811

E-mail: info_ap@u-blox.com
Support: support_ap@u-blox.com

Regional Office Australia:

Phone: +61 284482016
E-mail: info_anz@u-blox.com
Support: support_ap@u-blox.com

Regional Office China (Beijing):
Phone: +86 1068 133545
E-mail: info_cn@u-blox.com
Support: support_cn@u-blox.com

Regional Office China (Chongqing):
Phone: +86236815 1588

E-mail: info_cn@u-blox.com
Support: support_cn@u-blox.com

Regional Office China (Shanghai):
Phone: +86 21 60904832
E-mail: info_cn@u-blox.com
Support: support_cn@u-blox.com

Regional Office China (Shenzhen):
Phone: +86 7558627 1083
E-mail: info_cn@u-blox.com
Support: support_cn@u-blox.com

Regional Office India:

Phone: +91 8040509200
E-mail: info_in@u-blox.com
Support: support_in@u-blox.com
Regional Office Japan (Osaka):
Phone: +81 66941 3660
E-mail: info_jp@u-blox.com
Support: support_jp@u-blox.com
Regional Office Japan (Tokyo):
Phone: +81 35775 3850
E-mail: info_jp@u-blox.com
Support: support_jp@u-blox.com
Regional Office Korea:

Phone: +82 2542 0861

E-mail: info_kr@u-blox.com
Support: support_kr@u-blox.com

Regional Office Taiwan:

Phone: +886 22657 1090
E-mail: info_tw@u-blox.com
Support: support_tw@u-blox.com
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